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1. Open Data into ioGAS
i0GAS supports the following file types:

« I0GAS (.gas files)

» Tab-delimited text (.txt files)

o Comma-delimited text (.csv files)

o Excel (.xls, .xlIsx files)

« XRF (REFLEX & Olympus .csv & Niton .ntg files)
« Maplnfo GIS (.tab files)

« External databases:
« IMDEXHUB-IQ

« acQuire GIM Suite
o MS Access

« SQL Server

o ALS Webtrieve

o Live links:
« Leapfrog Geo*

o GOCAD Mining Suite*
o Geoscience ANALYST
« QGIS

* purchased separately

Open Excel File

1. Click the Open button on the File ribbon, or any other functional ribbon (other
than Help).
2. Browse to one of the following locations depending on the installed operating sys-
tem:
« Windows (64-bit): C:\Program Files\ioAnalytics\ioGAS-64.Ver-
sion\demodata folder
« Mac installation: ioGAS Applic-
ation\Contents\Resources\app\demodata folder
3. Use the drop-down arrow next to Files of type: and select Excel Spreadsheet files
- all (.xIs, .xlIsx files).
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4. Highlight the demo.xlsx file and click on the Open File button.

ﬁ Open File

Loak in:

2

Recent [tems

Desktop

=
==

Documents

=

This PC

&

Metwark

demodata

@ demo.drillholexlsd

ﬁ demo.xlsx
Files of type: | Excel spreadsheet files - all {.ds, .xdsx files) “ Cancel

Alternatively drag and drop the file from Windows Explorer directly into ioGAS, or copy

data open in Excel into the system clipboard and use the File> U Open from
Clipboard ribbon option.
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2. Define Column Types

Generally when a dataset is first imported into ioGAS the Column Properties dialog is
displayed. This is where columns in the dataset are matched to columns required by
ioGAS in order for data to be plotted successfully.

ﬂ Column Properties

Spedial Columns

D Sample Mum L
East East_AMGS4_z51 w
Maorth Morth_ AMGE4_z51 e
East/Morth Projection AMG (AGD 84) UTM Zone 51 L
Elevation w
WGE584 Longitude (decimal degrees) Long_WGS84 ~ | (Google Earth Expart)
WGS84 Latitude (dedmal degrees) Lat_WGE584 w
Date/Time ~

Column Mame and Type

- Counts

Original Name Alias Type Humeric Text Nulls
Sample Mum - Kg Sample Mum ~ | i |Text w~| 0 999 1] -
East_AMG34_z51 L I‘-’o East_AMG34_z51 ~ | i |Numeric ~ | 999 0 a
Morth_ AMGB84_z51 - Kg Morth_ AMGS84_z51 ~ | i |Numeric w889 0 a
Long_WG584 4= I‘-’o Long_WG584 ~ | iy |Numeric ~ | 999 0 a
Lat_WG584 - ICU Lat_WGE584 ~ | i |Numeric ~ | 999 0 a
Regolith Unit 4= L) Regolith Unit v | iy [Text ~ |0 999 0
Geology - Kg Geology ~ | i |Text w~ | 0 299 a
Sample Medium 4= L) Sample Medium v | iy [Text ~ |0 999 0 v
£ >
Column Colour Legend File contains 999 rows and 41 columns

@ Text @ Numeric @ MNumeric, Aliased
@ Non-plot & Numeric, Derived @ Mumeric, Aliased, Derived 4= Reset Aliases Kgy Guess Aliases X Cancel

¢ Name Error

Special Columns

This section is where the sample number and coordinate columns in the dataset are
selected so they can used to display data in the plot windows. i0GAS will use the
column names in the dataset to automatically assign the special columns. The columns
can be manually changed to the correct ones or left blank if the dataset does not contain
any matching columns.

« ID - Unique sample identifier.

« East/North - X and Y coordinate columns. Used to display data in all spatial map
views. Generally these will be in a projected coordinate system such as UTM
coordinates.
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« East/North Projection - Coordinate system used for East/North columns above.
This is the projection that is used in the geographical file exports, e.g. gridded
images as GeoTiff Images or ER Mapper grids, ArcGIS and Maplnfo exports

« Elevation - Z value column. Required to display data in 3D Attribute Maps.

« WGS84 Longitude/Latitude (decimal degrees) - Separate X and Y latllong
coordinate columns in WGS84 decimal degrees required in order to export data to
Google Earth.

« Date/Time - ioGAS recognises time/date data in Excel or ISO8601 format. Assign
a date/time column here to ensure data is displayed correctly in the Data View
window, the Line Plot tool and tooltip labels. Note that ioGAS does not support
timezones.

1. Match the columns in the demo dataset to the following Special Columns in
i0GAS:

o ID =Sample Num

. East =East AMG84_z51

o North = North_ AMG84 z51

« East/North projection = AMG (AGD84) Zone 51

« WGS84 Longitude (decimal degrees) = Long_ WGS84
« WGS84 |atitude (decimal degrees) = Lat. WGS84

Column Name and Type

In the Column Name and Type area ioGAS automatically assigns each column in the
dataset as Numeric or Text. Analysis data to be used in plots is generally numeric
whereas text data is used to 'group' data, for example Regolith Unit, Geology, Sample
Medium, etc. If a column is imported as a text field yet contains numeric data then the
column can be re-assigned as a numeric column and vice versa.

In some cases it may be useful to assign columns as Non-plot. Examples of non-plot
columns may include Sample ID or coordinate columns that will not be used in plot
generation or data analysis.

2. Scroll down and have a look at the different column types assigned to this dataset.

Text columns are denoted by a black circle and non-plot columns with a grey
circle. Numeric columns can have either a blue circle or a green circle next to
them depending on whether they are "aliased" or not. See Step 4 for more
information on aliasing variables. Red circles denote that there is a problem such
as duplicate column names and will need to be fixed before exiting this dialog.
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i0GAS lists the number of samples in each column that are numeric, text or null
(blank) on the right-hand side of the dialog. At the bottom of the dialog is the
number of rows (999) and columns (41).

3. Place the cursor over the original column name (without mouse clicking) to view
tooltip information about the data in the selected column. Text columns display the
individual categories and numeric columns display min, median and max values. If
the tooltips do not appear, click within the Column Properties dialog to make it act-
ive and try again.

It is possible to plot data and use many of the functions within
ioGAS without having an ID column or coordinate columns
selected.

It is also possible to remove any columns before import by clicking on the cross next to
the column to delete. These columns will be permanently removed from the imported
dataset when the OK button is selected.
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3. Set Column Alias Names

One very important feature of ioGAS is that if the element and the units that the values
are captured in is known for each column, i0GAS can perform unit or element/oxide
conversions on-the-fly in order to use the data with the classification diagrams,
calculations and spider plot normalisations shipped with the program if the data is not
already in the required format.

ﬂ Column Properties

Spedial Columns
D Sample Mum e
East East_AMGS4_z51 w
Morth Morth_ AMGE4_z51 e
East/Morth Projection AMG (AGD 84) UTM Zone 51 e
Elevation w
WGE584 Longitude (decimal degrees) Long_WGS84 ~ | (Google Earth Expart)
WGESB4 Latitude (decmal degrees) Lat_WGsa4 ~
DateTime v
Column Mame and Type
- Counts
Original Name Alias Type Mumeric  Text Nulls
= A
Cao += Ky Cal_pct] E @ Numeric -~ 999 0 ]
Ca0_pct - i
Na20 - ® |humeic | o3 0 o
KO Cal_ppm
k20 + %y Cd_pet @ MNumeric  ~ | 999 0 0
Cd_ppm
P205 - Ky Cd_ppb @ |[Numeric  ~ | 999 0 0
Ce_pct
s 4= L) Ce_ppm @ Numeric w999 ] 0
Ce_ppb
Au_ppb - Kg Ce203_pet @ MNumeric w889 0 a
Ce203_ppm
Ba 4= L) Cl_pct @ Numeric v | 999 ] 0
Cl_ppm .
Ce - Kg ol ppb @ MNumeric w889 0 a
Co_pct .
Cr 4= L) Co_ppm @ Numeric v | 999 ] 0
cu | % Co_ppb @ Numeric | 999 0 o
CO2_pct
La - Ky CO2_ppm @ |Numeric | 999 i 0
CO3_pct
Li += Ky CO3_ppm @ |Numeric w999 0 0
Cr_pct
Mo 4= Kg Cr_ppm @ Numeric w999 ] 0 .
. Cr_pph >
Cr203_pct
Column Colour Legend Cr203_ppm = File contains 339 rows and 41 columns
@ Text @ Numeric @ MNumeric, Aliased
@ Non-plot & Numeric, Derived @ MNumeric, Aliased, Derived  Emeleas Ly e X Cancd
¢ Name Error

If ioGAS can already guess the "aliased" name from the original column name it will
attempt to automatically assign an "aliased" name when the file is imported. E.g. Au_

ppb
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Alias Columns

Use the following steps to "alias" the columns in the demonstration dataset to standard
element/unit names:

1. Click on the Guess Aliases " © **= A2 button. i0GAS automatically guesses

the element and unit from the original column name for all columns. To alias a

single column at a time use the Guess Alias "9/ putton next to each variable.

2. ltis important to check to make sure that the correct element/oxide/unit com-
bination name is applied.

To manually assign an alias name to a column select the appropriate
element/oxide/unit combination from the Alias pull-down list. To reset a single

column back to the original name click on the Reset Alias * button next to each

. . 4= Reset Aliases
column or reset them all using the Reset Aliases button.

3. Observe the original names in the demonstration dataset compared with their
"aliased" names. The blue circles next to each variable are now coloured green to
indicate the variables are "aliased".

In ioGAS all variables can be renamed as desired with the new name used
everywhere in the program. To enter a nhew name for a column simply
overwrite the one displayed in the Alias column for that variable.

4. When you are satisfied that the columns are "aliased" correctly click OK to pro-
ceed.

The Column Properties settings are retained when the file is saved in ioGAS format and
can be modified at any time by clicking on =l Column Properties in the Data ribbon or

from the Data drop-down menu on all ribbons (except File & Help).
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4. User Interface & Attribute Map

The demo dataset is now loaded into ioGAS with the file name and path displayed in the
title bar of the program.

-
[ Quick access toolbar ]\Ev %O~ 0

ol R Bm S = % EE]
ek & 0 - & Ribbon
Variable  Attribut rid Legend Windows Settings
sthoram | Map  Map v - - - toolbar
Maps Window

Title bar showing ioGAS version, ‘

File Home Data Calculation Analysis Graph Map Structure Diagram
] OpenRecent » [ Copy Window mm ~
pen Recent B 2, Copy Window i RO
D) Open Chedpoint » 0, Save Checkpaint 2 i UL
Save Select Attribute Data Pause
- T Save Template Variables v Manager h Updates

Tools

Open
v 4\ Revert to Saved

X‘I

Open

filename, file path & selected variables

e Coour - | Slshape- Nllsie- Y Ater-
Name visible Colour Rows Rows visble
Defauit Colour L J 999 999
= e) Ba Giobal
Sample Num v | 10EqualBins | | [Gh Auto-attribute
> Al Visble 28 All invisble [/ save Attributes %l Load ttributes

|

Attribute
Manager
Status bar Memory meter Progress bar

The ioGAS user interface is comprised of a number of components:

Title bar

The Title Bar displays the ioGAS version, build and the file name and file path of the
currently open dataset.

Ribbon Toolbar

The tabs along the menu bar at the top of the screen open a corresponding ribbon
toolbar where features are grouped into bands of related functionality. Frequently used
functions are laid out as large icons, many with related functions in drop-down menus.
Less frequently used functions are laid out as small icons.

If this is the first dataset loaded into ioGAS for this work session then the Home ribbon
toolbar should be currently displayed. If not, click on the Home tab to display this ribbon.
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Quick Access Toolbar

On the right side of the menu bar is the Quick Access Toolbar containing tools that are
relevant in any context: show/hide ribbon, favourite tools list, open windows list, display
attribute legend and help.

Attribute Manager

The Attribute Manager controls the way each data point is "attributed" when it is
displayed in a plot window with respect to colour, shape, size and visibility. The Attribute
Manager can also be used to set a filter on the dataset in order to create a subset of
data.

Status Bar

Displays information about toolbar icons along with other important warning and error
messages when processes are run to let users know if there are any problems, e.g.
when data cannot be logged due to 0's or negative values, missing variable data when
displaying mineral nodes, etc. Warning messages are displayed in red.

Progress Bar

Some processes can take a while to complete. This orange bar can be used as a visual
aid to view progress.

Memory Meter

The Memory Meter shows the actual memory being used by i0GAS, as a fraction of
available memory. The meter is intended as a guide to help the user decide when to
close windows as the memory gets close to its limits.

Attribute Map

An Attribute Map is a pseudo-map or geographical view of a dataset that plots the X
coordinates against the Y coordinates. It is used to view a dataset in a spatial context
and is one of the main plot types used with Google Earth and GIS programs such as
ArcGIS or Maplnfo.

1. Click on Attribute Map on the Home ribbon.
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When the Attribute Map is open, a humber of buttons are displayed vertically on the
right-hand side of the screen. This is the Attribute Map context toolbar and contains tools
relating to this plot window. To make the context toolbar active click in the plot window
or on the window title bar. Place the cursor over each toolbar button to view information
about each tool in a tooltip.

To move the Attribute Map window click on the window title bar and drag to a new
location while holding down the left-mouse button. Plots and other windows open in
i0GAS can be re-sized by placing the cursor over one of the edges of the window and

then dragging it in or out. Minimise, Restore and Close buttons [= [ (= are also
available in the top right hand corner of each open window.
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5. Select Variables

Before any data can be displayed in a plot window (aside from an Attribute Map if
coordinates are present) the variable columns must be selected for use. The current
variable selection is generally shown in the main window title after the file name, which
in this case is empty as there are no variables selected yet.

Notice that a number of icons are greyed out on the ribbon. This also indicates that
either no variables are selected for use or that not enough variables are selected to
display that particular plot, e.g. a ternary plot requires three variables to be selected
before the icon is active.

The Select Variables tool is located on the Tools band of the Home ribbon along with
other commonly used tools such as the Attribute Manager, Data and Pause Updates
which will be discussed later in this tutorial. This suite of tools is also available on the
Common Band on most of the other ribbon toolbars.

»

Select Attribute Data Pause
Variables~  Manager - Updates

Tools

1. Click on Select Variables on the Home ribbon to display the Select Variables
dialog.

2. Add the following variables to the Selected window: Zn_ppm, Ni_ppm, Fe203_
pct and Cu_ppm.

To select an individual variable double-click on the entry in the Available window
to move it across to the Selected window or use the arrows in the middle of the
dialog. Multiple selections can be made using the Ctrl/Shift keys.
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[ Select Variables (4 / 41) =& [

Group
Provided: ELEMEMT GROLPS : e

History: e

Available Selected

Sample Num ~ = Zn_ppm
East_ AMGB4_z51 Ni_ppm
Morth_ AMGB4_z51 Fe203_ pct
Long_WG5S84 Cu_ppm
Lat_WGS84
Regolith Unit
Geology
Sample Medium
Si02_pct
miD2_pct
Al203_pct
MgD_pct
Cal_pct
Na20_pct

K20 _pct
P205_pct
As_ppm

Au_ppb

B2 nnuno

it

O ey

Observe that the colour of the variable columns match the colours used in the
Column Properties dialog. All of the selected variables are green as they are
numeric columns that have been "aliased" to the standard i0GAS element/unit
names. The black variables are text fields and can be selected for use with plots if
they will produce meaningful results. Numeric variables which have not been
aliased will appear in blue.

To sort the order of the variables alphabetically in the Available window use the
right-mouse button. The variables are sorted within each "type", e.g. text, numeric,
aliased, etc. Click again to return to file order.

The order of the variables in the Selected window can be modified using the Up
and Down arrows or by dragging to a new location with the mouse cursor. For
some plots such as XY Scatterplots the first variable is used as the X axis when
there are multiple variables to be plotted. Ternary plots use only the first three
variables in the Selected window so re-ordering is often required to ensure the
correct variables are displayed.

Once you are more familiar with the software there are a couple of ways to select
multiple variables at a time rather than having to select them each time:
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Provided

Drop-down list containing groups of commonly used elements provided by
i0GAS. Individual variables can be added or removed from these selections.
Provided groups include:

« Element Groups - Majors , Immobile, REE, PGM

« Deposit Style - Porphyry Cu-Au, Epithermal/Meso-
thermal/Orogenic/Laterite Au, IOCG, MVT, VHMS, plus
many more.

« Secondary Scavenging - Fe and Mn Oxides
« Goldschmidt - Chalcophile, Lithophile, Siderophile
History

Each variable selection is saved and is available to be selected for use
again within the current dataset from the History pull-down list.

3. Click OK to exit the dialog.

Now that a number of variables are selected for use all of the tools on the Home ribbon
are now active. The current variable selection is also displayed in the ioGAS title bar
after the open file name.
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6. Validate Data

ENEEE = . P ] | .
ﬁ E=:== = Attribute Multivariate (‘_"l II! —
LT “ BS L0 Attribute Duplicates [ = S
Data Missings Searchand  Remove Remove
Doctor Analysis .- Generate Random Subsample = Replace - Columns Invisible Rows
Validate Edit

1. Click on the Data tab to open the Data ribbon and have a look at the options in the
Validate and Edit bands. These include:

;g\ Data Doctor

The Data Doctor tool displays the number of null, 0, -, > and < records for
each of the selected variables. Using this tool It is possible to replace below
detection limit values with a %2 positive value or custom value and above
detection values with a custom value. Colour attribute any of these samples
in open plot windows to see where they are located. Any changes made to
the data are recorded in a log file for future reference.

Om

HES Search and Replace

Replace text or numeric entries in selected columns or the entire dataset. All
modifications are reported in the change log file.

o Convert Zeros to Nulls (Coordinate Columns) (under Search and
Replace drop-down menu) - Replace zero entries in coordinate
columns with null values to prevent them from plotting at 0,0 in map
views.

2. Clickon ;g) Data Doctor.
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E Data Doctor [Zn_ppm, Ni_ppm, Fe203_pct, Cu_ppm]

Data Problems

i Apphy Replacement Replace
Variable Problem Value Count % Attributes Value Value
In_ppm
Megative = 71 7.1 ] 1 ~ | [
Ni_ppm
No Probs
Fe203_pct
No Probs
Cu E?m
Blocnties 2 168 B8 [] 1 ~ | [
| 231 rows without problems
[] Suggest row by row ] Suppress Megative Rule ] Attribute Al ] Replace Al

805,999 rows without any problems

Show Log =p Apply 4~ Undo Copy ¥ Close

The Zn_ppm and Cu_ppm columns contain some below detection limit data. The
validation type, the value, the number of samples with this value and the % of
affected valid data is displayed along with a recommended replacement value
which in this case is 1 (the half positive value of the below detection limit, i.e. -2).

3. Check the Replace Value box next to each entry and then click Apply.

As the replacements are made the updated Data Doctor reports that there are now
no data validation problems with the dataset.

4. Click on the Show Log button at the bottom. In the Change Log window scroll to
the right to view the number of Zn_ppm and Cu_ppm occurrences that have been
updated with the new replacement value.

The Change Log file lists all changes to a dataset from when it is firstimported into
ioGAS and records all data validation replacements, columns removed and rows
deleted. The Change Log can be accessed at any time using the Data>Show
Change Log ribbon option.
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5. Select Close to exit this window and then Close to exit the Data Doctor window.
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7. Display Data in Tabular View

The View Data tool displays the dataset in a spreadsheet or tabular view as
rows/columns.

1
1. Select mmm Data from the Tools band of the Home ribbon. This will display all the
columns in the dataset regardless of what variables are selected.

2. Use the scroll-bars to scroll up and down and left and right to get a feel for the
columns in the dataset. Observe the colour, shape, size and visible columns on
the left-hand side. These columns show the current attributes that are applied to
each data row. These are currently set to the default attributes which are a black
circle, 6 ptin size.

3. Sort a variable column in ascending order by left-mouse clicking once in the
column header. Click again in the header to reverse the sort. The [Order] column
is automatically generated when the data is imported and can be used to sort the
data back to its original import order at any time.

4. ltis possible to click on rows in this view and apply colour/shape/size attributes to
the selection using the Apply Attributes to Selection button. This will be covered
later in this tutorial. Data can also be copied into other programs using the two
Copy buttons at the bottom of the dialog.

5. Close the Data window using the X in the top right hand corner.

i Dota (a1 =l =
[Colour] | [Shape] | [Size] | [visible] | [Order] | Sample Num | East_AMGB84_z51 | Morth_ AMGB4_z51 | Long_WGS84 | Lat_WGS84 | Regolith Unit | Geology | Sample Me

L L ) ¥ 0|GRA 102 324556 7146096 121.251549 -25.791384|D9 PEp SPL ~
L L &) ¥ 1|GRA 95 322521 7148864 121.23163 -25.766155|D9 PEp SPL

L L &) A 2|GRA 98 318667 7146832 121.192937 -25.784023|DC PEp SHTW

L L & A 3|GRA 96 317583 7143512 121.182361 -25.768725|DC PEp STRM

L L & A 4|GRA 83 3143966 7151216 121.156653 -25.743992|DC PEp SHTW

L [ &) A 5|GRA 82 317537 7153360 121.132569 -25.724963|DC PEp SHTW

L [ 2 A &|GRA 79 314597 7153936 121.153355 -25.719395|DC PEp STRM

L L 6| Y 7|GRA &7 315930 7157808 121,197552, -25,684995 DC PEp SHTW

L L 6| ¥ 8|GRA TS 323407 7154336 121.241189 -25,716872 |DC PEp SHTW

L L 6| ¥ 9|GRA 91 330633 7149696 121,312557, -25,759605 DC PEp SHTW

[ [ ) Y 10| GRA 83 325158 7150032 121,258069 -25,755929 E PEp STRM

[ [ ) Y 11|/GRA 71 326439 7154944 121.271479 -25. 711746 E PEp SHTW

L L 6| ¥ 12|RHO 126 346432 7154624 121,475228 -25,355772|DC Pt SHTW

L L 6| ¥ 13|RHO 124 342437 7134588 121,435545 -25,354778 |DC Pt SHTW

L L 6| ¥ 14|RHO 109 322226 7198496 121,235262, -25,318134|D9 Pt SPL

L L 6| ¥ 15(RHO 110 313786 7198416 121.151437| -25.317829|D9 Pt SPL

L L 6| ¥ 16(RHO 111 304300 7197872 121.057162, -25.321527|DC PEY STRM

L L &) ¥ 17|RHO 103 301958 7202256 121.034544, -25.281651|D9 Pt SPL

L L & A 18|RHO 116 301979 7196832 121.033963 -25.330607|DC pPEf STRM

L L & A 19|RHO 107 309329 7199643 121.107351 -25.306147|D9 Pt SPL

L L & A 20|GRA 107 328252 7144064 121.288135 -25.810163|DC PEp STRM

L [ &) A 21|GRA 113 328959 7141792 121.294391 -25.830753|E PEp STRM

L L 6| Y 22|GRA 105 325339 7144176 121,2596 -25,808813 DC PEp SHTW

L L 6| Y 23|GRA 114 325855 7141744 121.263927 -25.83082|DC PEp STRM

L L 6| ¥ 24|GRA 121 325123 7138704 121.286151 -25.858527 D9 PEw SHTW

L L 6| ¥ 25|GRA 110 321558 7142032 121.221111 -25.827702 |DC PEw SHTW

L L 6| ¥ 26(RHO 92 299776 7205934 121013432 -25.247714[E PM STRM

L L 6| ¥ 27|RHO 80 209263 7208288 121,00868 -25,226851|D9 PM STRM ©

< >
Copy Al Copy Selected li‘ Apply Attributes to selection | 999 of 999 rows
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8. Navigation Tools and Labels

1. Go back to the Attribute Map window that was opened earlier.

To re-open this plot select %/ Attribute Map from the Home ribbon. The context
toolbar is displayed on the right-hand side of the screen. Maximise the window to
make it easier to see.
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On the Attribute Map toolbar are a number of standard tools available to navigate within
a plot window.

Zooming and Panning

2. Tozoomin on an area click on E. Zoom to Box and drag a box in the window
over some data points using the left mouse button. The window contents are
zoomed to the extents of this box. Alternatively, place the cursor in the plot window
and use the scroll bar on your mouse to zoom in and out at the cursor location.

3. Select ) Pan and click and drag the left-mouse button in the plot window to pan
the view.

4. Right-mouse click in the plot window and select Zoom Previous from the pop-up
menu. To restore the data to the original extents right-mouse click again and select
Zoom to Data.
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5. You can also use the :‘:L Dynamic Zoom tool to zoom in and out by holding down
the left-mouse button in the plot window and then dragging it up to zoom out or
down to zoom in. The scroll bar on the mouse can also be used to zoom in and out
if available. Restore the plot view when you are finished.

View Data Tooltips and Labels

Place the cursor over a data point in the plot window (without clicking) until a
tooltip information box is displayed. The information displayed in this box includes
the ID, East and North coordinates, any colour/shape/size attribute groups which
are assigned and any data columns selected to be displayed as labels. e.g.
Regolith and Geology units to which the sample belongs.

If the tooltip is not displaying, click in the title bar of the Attribute Map
window to make it active and then try again.

6. Click on Select Labels on the Data ribbon. This is where it is possible to
choose which other columns will display in the tooltip information box.

-

Select Labels

Available

Lat WGS84
Sample Medium
Si02_pct
miD2_pct
Al203_pct
Fe203_pct
MgO_pct
Cal_pct
Na20_pct
K20 _pct
P205_pct
Ba_ppm
Ce_ppm
Cr_ppm
Cu_ppm
La_ppm
Li_ppm
Mo_ppm
Hb_ppm
Ni_ppm
Rb_ppm
Sc_ppm
Sn_ppm

SF Mnm

S BRI S

¥ 0K

ERECh
Selected

Sample Num
Regolith Unit
Geology
As_ppm
\Au_pphb
Pb_ppm

¥ Cancel
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7. Selectthe Sample Num, Regolith and Geology columns and a couple of other vari-
ables and move them into the Selected window. Click OK to exit the dialog.

8. Click back in the Attribute Map window to make it active and place the cursor over
a sample. The new label columns are now displayed.

- e ® W
e, o . .'__'_-::--..._.
P e tew w s 3 . sus ¥ 8 o oag
e s ¥ Yes . Te%sa s 0,0
i T e ne® et 8o a0
teet L lllezev:
" s . I0: MET 102
s o % e [location: East_AMGE4 251 = 2702900, Morth_ AMGE4_z51 = 7201136.0

s o % _edAttributes:

al® @ g

.---- * . w iy T W W v
e T 5 8 o e, e ¥ g g8, P,y

«® T et eet’ 4 te sy et e, g0
woaet, s e 8 0 s atre,,
-"'lnrl aty . -"‘-. e . % ot ®
s %L g o® s se P e Sae v,

9. To display the Sample Num as label in the attribute map window select Rendering
Settings on the toolbar and check the Show item labels box. Click Apply to view
the labels in the plot window. Zoom in to display more labels.

Attribute Maps can also be created from the Map ribbon.
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9. Open Multiple Plot Windows

Now it is time to open some of the other plots available in ioGAS and look at the different
ways that they can be displayed.

Scatterplots

1. SelectI_XY Plot from the Plots band of the Home ribbon.

See that only three XY plots are created. This is because although four variables
are selected: Zn_ppm, Ni_ppm, Fe203_pct and Cu_ppm, the first variable Zn_
ppm is used as the X axis and the other variables as the Y axis.

2. With the XY Plot window as the active window, select “ Log X Axis and i Log
Y Axis from the XY toolbar to change the X and Y axes from raw data values to log
scale.

3. Click on each of the W ori buttons to change each ofthe X and Y axes to a
Power Transformed axis. ioGAS uses a Lambda power transformation method to
de-skew data so it more closely approximates a normal distribution. Click on these
buttons again to return to linear axes.

Probability Plots

4. Selectlﬁ Probability Plot from the Plots band of the Home ribbon.

Each variable is displayed as an individual probability plot in a single window.
Observe that the Probability toolbar contains similar zoom, pan and log/power
transform options as the XY toolbar.

5. Clickon P to display probability values along the X axis instead of N-Score (std
dev) values.

6. To change the view to a cumulative frequency plot distribution click on the |'& but-
ton. To return to normal probability right-mouse click on the button and select
Normal.

Histograms
7. Todisplay individual plots in a tabbed window go to the Window band, click on the

arrow under % Settings and choose Tabbed windows from the drop-down
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menu. A circle is placed next to this menu entry to show this window mode is selec-
ted.

8. Select Histogram from the Plots band.

Observe that each of the variable histograms is displayed in a separate tab in the
same plot window instead of all in the same plot window like the XY and
probability plots. Click on the tabs to view each histogram.

9. The histograms show the number of samples in each binning range. Use the @

and ¥ arrows on the Histogram toolbar to increase or decrease the number of
bins.

Arrange Windows

There should now be four plot windows open in i0GAS but they are most likely all
displaying on top of each other.

10. To arrange multiple windows click qb Cascade on the Window band to view all
the windows with their title bars visible.

|
11. Now select™ [ Tile to view all the plot windows without overlapping.

Histograms [Zn_ppm, Ni_ppm, Fe203_pct, Cu_ppm] = |- [3m | |- ¥¥Plot [Zn_ppm, Ni_ppm, Fe203 pct, Cu_ppm] o |E &=
Zn_ppm Nippm Fe203 pet | Cu_pom} Zn_ppm : Ni_ppm Zn_ppm : Fe203_pct
Cu_ppm 7 w{§
+ 50
325 E" 0 PUREL B
300 8 Fad
. % 30 b .
276 . & 20 . .o,
250 10 ‘
225 * o *
o 50 100 150 200 250 300 350 0 50 100 150 200 250 300 350
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s .
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125 s
100 oo - .
7 Es
50 RI 50 o *
2 sey
25 25 .
o . e —_ 2N .
o .
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|~ Probability Plot [Zn_ppm, Ni_ppm, Fe203_pct, Cu_ppm] = | B |52 | Attribute Map o |E &=
Zn_ppm Ni_ppm Attribute Map
. 751 " N
7,230,000 .’ :.
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East_AMGE4_251
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12. Click on % Save Checkpoint in the Save band on the Home ribbon. Enter a name
for the checkpoint such as Multiple Plot Windows and click OK.

A checkpoint saves the currently open plot windows and settings and can be
restored at a later pointin time.

13. Go backto % Settings and choose Normal windows from the drop-down menu
to return to the default window display. The selected window mode will apply to
new windows only, not those already open.

XY, Probability Plots and Histograms can also be created from the Graph
ribbon.
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10. Apply Colour/Shape/Size Attributes

Now that there are some plot windows created, this next section looks at how to change
the colour, shape and size attributes for individual data points, apply them to data
selections and turn the visibility of data points on and off. This is all controlled by the
Attribute Manager.

1. Select ‘ Attribute Manager from the Tools band on the Home ribbon. The Ctrl-
A keyboard shortcut can also be used to open the Attribute Manager window.

The Attribute Manager contains three main tabs, one each for colour, shape and
size. This means that for every data point the values for up to three variables can
be displayed simultaneously, one for each attribute. By default, all of the samples
in the dataset will be attributed unless a subset of data is selected for use in the
Filter tab. When a Filter is set only the filtered data samples will be attributed.

Auto-Attribute Text Data

Auto-Attributing can be used to apply attributes to data based on unique values in a text
column.

2. With the Colour tab active, select Regolith Unit from the drop-down list and click
on the Auto-Attribute button.

Attribute Manager

*2 Colour - Regolith Unit .‘i: Shape - Geology -l Size - '.' Filter -

Mame Visible Colour Rows Rows visible

Default Colour ] 0 0
09 9 215 215
DA 152 152
DC 9 479 479
E Y 153 153

[ i) D Global

Regolith Unit ~ || 10 Equal Bins _l @ Auto-Attribute
&> All Visible 2% All Invisible |-/ save Attributes [ | oad Attributes
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The data is now coloured by Regolith Unit in every plot window. The number of
data points in each colour group is displayed along with how many of the points
are currently visible.

3. Click on the Shape tab this time. Select Geology from the column pull-down list.
Click on the Auto-Attribute button.

The data points are now coloured by regolith unit with the shape representing the
underlying geological unit.

Attribute Manager

i
% Colour -Regoiith Unit o7 Shape -Geology ¥l size - W Aiter -
Mame Visible Shape Rows Rows visible
Default Shape & ] 0 A
Ab ] 15 15
Ag 4 196 196
PEF ry 155 155
PEp * &7 &7
PEw i 243 243
PEy 1 97 97
PM 1 94 94
PMo - 0 0
PSg O 23 23
PYj O 28 28
Ped 7 7 7 v
) i) D ] Global

Geology ~ || 10 Equal Bins [l Auto-Attribute

<¥> All Visible 38 All Invisible 1/ save Attributes "l Load Attributes

Show Legend

The legend window is another way of displaying the current Attribute Manager settings

([ J
4. Click on @ Legend on the Window band of the Home ribbon to open up a
separate Legend window. The legend window can also be opened up from the i ]
icon on the Quick Access toolbar or by the Ctrl-L keyboard shortcut.

5. To view the attributes in a combined legend, right-mouse click within the legend
window and choose Legend Mode - Combined/Separate. Click this option again
to return the default legend view.
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Legend @
Colour
Regolith Unit
@03

DA
@DC
$E
Shape

Geology
Wb
¥ g
A PEF
4 FEp
§ PEw
B PEY
I PM
== Flo
(Z1PSg
[pyj
5 Ped
NPt
Size
& Default Size
Label
Sample Num

The Label entry displays the currently selected label column should labels be displayed
in a plot window. The ID column as denoted in the Column Properties dialog is the
default label column.

Change Visibility
In the Attribute Manager it is possible to sub-set the data so that only data points from
particular regolith units are displayed. This is controlled by the visibility options.

6. In the Colour tab, uncheck the box in the Visible column next to the D9 and DA
regolith groups. The rows visible column is set to O for these groups.
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¥ Attribute Manager
(1] . .
25 Colour - Regalith Unit ;}.: Shape - Geology i Size - Y Fiter -
Mame Visible Colour Rows Rows visible
Default Calour ] 0 0
DS H ® 215 0
DA H 152 0
DC ® 479 479
E ® 153 153
i B B e
Regolith Unit v | 10 Equal Bins - HER R[5 Auto-attibute
<> all visible 28 Al Tnvisible 1/ save Attributes "8l | pad Attributes

Observe how the data points are removed from all open plot windows.

¢ Histograms [Zn_ppm, Ni_ppm, Fe203_pct, Cu_ppm]
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7. Clickon & Save Checkpoint in the Save band on the Home ribbon. Enter a name
for the checkpoint such as DC + E Regolith Units and click OK.
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8. Check the boxes to re-display the samples or click on the All Visible button at the
bottom of the Attribute Manager window.

Auto-Attribute Numeric Data

Auto- Attributing can be used to apply attributes to data based on data
percentiles/custom ranges for numeric columns. For numeric data columns, data points
are attributed according to a selected percentile binning range, e.g. 5 or 10 Equal Bins,
Quartile, Progressive, etc and then coloured using one of the supplied colour ramps. Itis
also possible to create custom bin ranges rather than percentiles which can be applied
to different datasets.

9. While still in the Colour tab select a numeric variable column such as Cu_ppm
from the column pull-down list.

10. Click on the down arrow next to 10 Equal Bins and select Progressive from the bin-
ning range pull-down list. The Progressive binning range divides the data into per-
centiles based on 30, 60, 80, 90, 95 and 98% cut-offs.

11. Click on the arrow next to the colour ramp and look at the available options. Use
the defaultioGeochem Non-linear colour ramp at the top of the list.

12. Click Auto-Attribute to apply the colours and select YES to overwrite the existing
colour attributes.
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Cu_ppm to 5 [30.00%] ® 300 300
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14. To change the assigned colour/shape/size of an attribute double-click on the attrib-
ute (e.g. red circle, square, etc) and select a different one from the colour palette or

drop-down list (for shape/size).
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Attribute Manager

Default Shape @
*2 Colour - Cu_ppm Progressive .‘5: Shape - Geology _,j': Size - W Filter -
Mame Visible Shape Rows Rows visible
Default Shape ® 0 g~
o mem. s
Ag - 196 196
PEF v 155 155
PED &7 &7
PEw A 243 243
PEy * a7 a7
PM 1 94 94
PMo ] 20 20
PSg | 23 23
PYj - 28 28
Ped O 7 7w
= ) L o Al ] Global
LF, v
Regolith Unit ~ || 10 Equal Bins i E Auto-Atiribute
<
< all Visible @ All Invisible ] ve Attributes "8l Load Attributes
[
I

15. Attributes can be combined by dragging one group onto another group, e.g. drag
the Geology group PMo onto PM to create a combined group named PM + PMo.

16. ltis also possible to change the name of an attribute by double-clicking in the
Name column and overwriting the entry with a new one. Any changes are dis-
played in the Legend window but are not written back to the dataset.

Remove Attributes
17. Highlight the PEw entry in the Shape tab. To remove this entry from the list use the

@ button. All of the PEw samples now show the Default Shape.

18. To remove all the Shape attribute entries click on the @ Al button. All
samples now show the Default Shape.

19. To remove all the currently applied colour/shape and size attributes click on the
Global button.
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Attribute Filter

The Attribute Manager Filter is a way to create a subset of data to work with in io0GAS
without having to open up a new file. Applying a data filter enables only data points that
fit the filter criteria to be displayed in any open plot windows.

20. In the Attribute Manager click on the Filter tab.

21. Choose Sample Medium from the drop-down list and click the Auto-Attribute but-
ton.

Attribute Manager

*% Colour - .:-‘-‘ Shape - Elu Size - Y Filter - Sample Medim
Mame Vigible Rows All Rows

Default Filter ] 0 0

LAKE ] 0 33

SHTW 397 397

SOIL ] 0 93

SPL ] 0 191

STRM ] 0 280

e ) D a B ciobal

Sample Medium » || 10 Equal Bins E Auto-Attribute

<> Al Visible 2 All Invisible B save attributes I8 Load Attributes

22. Turn off the visibility for all of the groups, leaving only the 397 SHTW samples.

23. Click on % Save Checkpoint in the Save band on the Home ribbon. Enter a name
for the checkpoint such as SHTW Samples and click OK.

24. Experiment with Auto-Attributing data using different text columns and also with
numeric columns using different colour ramp/binning combinations.

Observe how the colour, shape and size attributes are only applied to the filtered

SHTW samples.
25. Filter attribute entries can be removed by clicking on the @ or
Al , —— o
@ buttons. Note that if any filter is active (i.e. some rows are
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excluded from the dataset using a filter), the icon on the Filter tab will be red
instead of blue.

It is possible to attribute data by applying the same variable to the colour,
shape and size attribute tab or apply three different variables.

Attribute Manager Window

The Attribute Manager window can be dragged outside of the application if dual
screens are setup to keep the Attribute Manager window open all the time. Alternatively,

select External Windows Always on Top from the % Settings drop-down menu to

keep the Attribute Manager displayed on top of other plot windows instead of
minimising.
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11. Make Data Selections

Selections can be made in ioGAS in two ways:

« Highlight Selections - select data points or rows in one window and the same
samples are highlighted in all other windows that support selection mode. The cor-
responding data rows for the highlighted points are also selected in the data view.
Highlight selections are temporary and are overwritten each time a new selection
is made.

« Attribute Selections - permanently assign colours, symbols or different sizes to
manually selected data points in a plot window

Highlight Selections

1. Select AP Attribute Manager from the Tools band on the Home ribbon or use the
Ctrl-A keyboard shortcut.

e : : All

. Remove any existing filters and/or attributes using the [% and
| Global

clota buttons.

. Cliclg_on the title bar of the Attribute Map plot window to make it active and click on

the '~ Select points using polygon button on the toolbar. This activates selection
mode and the colour of all of the points in the window is muted.

. Draw a polygon around a group of points in the Attribute Map by clicking with the
left-mouse button and double-click to close. To add another group to the current
selection hold down the Shift key.
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The highlighted points are displayed in yellow in all currently open plot windows and
any new plot windows that support selection mode. The corresponding data rows are

125000 150000 175000 200000 225000 250000 275000 300000 325000 350000 375,000 400000 425000
Zn_ppm East_AMGB4_z51

also highlighted in the data view window. While selection mode is activated, data
selections can be made in any open plot window.

5. To create a new selection, make any plot window active and draw a new polygon
around a group of points. This will replace the existing selection. Alternatively,
select rows in the data view window.

6. To zoom to the selected samples in a plot window, right-mouse click and choose
Zoom to Selected from the pop-up menu. This option may not be available for all
plot types that support selection mode.

7. Use the 7 Invert Selection tool to replace the current selection with the pre-
viously unselected data points.

8. Selection mode can be turned on and off in the plot window by toggling the N
Select points using polygon button. The current selection is retained in the "back-
ground" and can be re-displayed at any time. Selections can also be saved in
checkpoints.

9. To permanently attribute the selected points, click on the G Apply attributes to
selection button. Selections are attributed using a colour, shape and size attribute
scheme as designated in the Attribute Manager. See below for details on how to
set this up.
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10. To clear a selection completely and exit selection mode use the % Clear Selec-
tion button in any open plot window or the data view.

Attribute Selections

The steps below outline how to setup a colour, shape and size attribute scheme and
apply it to selected data points. The appearance of the data points is changed
permanently until such time as the attribute scheme is overwritten with a new one or
removed altogether.

1. Select the Colour tab and click on the Add an Attribute E:} button.
A new colour row is added under the default colour row and is coloured red.

2. Double-click on the New Colour entry to assign a name for the attribute (ie. High
Cu) and then click Enter. Make sure that the High Cu row is highlighted (in blue)
and that a red circle with "High Cu" is also displayed in the top right of the Attribute
Manager window.

3. Select the Shape tab and click on the Add an Attribute button. Change the shape
to a triangle. Select the row so it is highlighted in blue.

4. Repeat the process in the Size tab by making a new entry with a size of 10 and
selecting this row.

The shape and size attributes should display in the top right corner as New Shape
and New Size when they are highlighted correctly.
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5. Click in the Probability Plot window created back in Step 9.

Otherwise, click on the |4 Probability Plot on the Home ribbon again if the plot
window has been closed. Re-size this window to make it bigger and make sure
the Probability toolbar is visible by clicking in the plot window to make it active.

6. Select. I:Attrlbute Polygon from the toolbar.

7. Inthe Cu_ppm probability plot window, hold down the left mouse button and click
around the high values in the plot window to create a polygon (region) object.
Double-click to finish.

All of the data points within the polygon should now be attributed with a red
triangle 10 ptin size.
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10.

8. Select

Tile from the Window band to view all the open plot windows. Observe
the red triangle attributed points in the other plot windows. The Legend window is
also updated.

Leaving the High Cu samples attributed, repeat the process outlined above to
make another selection on the probability plot using a blue square 10 pt com-
bination. Assign a name for the new group in the colour tab.

Make sure that blue colour, square shape and Size 10 pt attributes are highlighted
in their respective tabs and displayed in the Attribute Manager top right corner
prior to making the data selection.

Drag the Probability Plot window to make it bigger and then zoom in on the Cu_
ppm probability plot to show the samples with values below the red triangles.

Using the Attribute Point "' tool click on individual points to attribute them as blue

squares. Observe how the samples are updating in the other probability plot win-

dows.
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11. Select

Data and left-mouse click in the [Colour] column header cell twice to
display the data in descending order based on colour. Observe how the colour,
shape and size attributes have been updated next to each row.
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12. Click on ~® Save Checkpoint in the Save band on the Home ribbon. Enter a name
for the checkpoint such as High Cu samples and click OK.

13. Open the .Attribute Manager again if it has closed (Ctrl-A) and remove all

i
attributes using the Giobal Global button. Experiment with creating dif-
ferent colour, shape and size attribute combinations and applying them to data
selections. View the results in the data table.

14. Close all plots at the completion of this exercise using %( Close All on the Window
band or use the Ctrl-Shift-W keyboard shortcut.
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12. Univariate Statistics

When analysing data it is useful to look at various statistical parameters for either the
entire dataset or for selected categories within a dataset. The selected categories are
based on the colour groups as set in the Attribute Manager.

Summary Statistics

1. Open an Attribute Map from the Home ribbon.

2. Open the ‘ Attribute Manager using the button or Ctrl-A and remove any exist-
ing attributes. Click on the Colour tab and auto-attribute the data using the Rego-

lith unit column.

3. Select z Summary Stats from the Stats band on the Home ribbon.
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]
. Summary Statistics - Univariate [Zn_ppm, Ni_ppm, Fe203_pct, Cu_ppm] o [[E- [
999 rows - Univariate IZn_ppm Ni_ppm Fe203_pct Cu_ppm
[visible] : Count Numeric 999 999 999 999 ~
[Visible] : Count Text 0 0 i 0
[visible] : Count Null 0 0 i 0
[Visible] : Count Negative 0 0 i 0
[Visible] : Count Zero 0 0 i 0
[visible] : Unique Values 30 44 773 63
[Visible] : Minimum 1 1 0.03 1
[visible] : Maximum 379 75 63.71 120
[visible] : Mean 21.563504 10.877873 10.554505 13.427427
[visible] : Median 13 10 6.06 11
[visible] : Range 378 75 63.68 119
[visible] : Interquartile Ra... 20 9 10.89 15
[visible] : Standard Deviati... 21.918727 3.199608 11.653192 12.983684
[Visible] : 1 percentile 1 1 0.4 1
[Visible] : 5 percentile 1 1 1.1 1
[visible] : 10 percentile 3 1 1.47 1
[visible] : 25 percentile 3 5 2.75 4
[visible] : 75 percentile 23 14 13.64 19
[visible] : 90 percentile 44 20 28.27 25
[visible] : 95 percentile 56 25 36.64 33
[visible] : 99 percentile a7 39 51.36 70
D9 : Count Numeric 215 215 215 215
D9 : Count Text 0 0 ] 0
D9 : Count MNull 0 0 ] 0
D9 : Count Negative 0 0 ] 0
D9 : Count Zero 0 0 ] 0
D9 : Unigue Values 36 24 177 26
D9 : Minimum 1 1 0.06 1
D9 : Maximum 145 76 43.42 70
D9 : Mean 10, 162791 6.065116 5.532186 5.009302
D9 : Median G 4 2.3 2
D9 : Range 144 75 43.36 69
D9 : Interguartile Range 3 7 3.62 5
D9 : Standard Deviation 17.718371 7.539023 3.21263 3.347584
D9 : 1 percentile 1 1 0.097a 1
D9 : 5 percentile 1 1 0.66 1
D9 : 10 percentile 1 1 1.006 1
D9 : 25 percentile 3 1 1.43 1
D9 : 75 percentile 11 2 5.05 6
D9 : 90 percentile 19 13 15,394 12
D9 : 95 percentile 29.2 17 27.718 18 W

In the Summary Statistics window all of the selected variables are displayed
along with a number of basic statistics for each regolith group. The values in each
group are also coloured according the colours in the Attribute Manager.

The values at the top in black are the calculated statistics for all visible data
regardless of colour group as denoted in the Attribute Manager.

. To change the displayed statistics click on IE| Choose Statistics on the Summary
Statistics toolbar. Check or uncheck the statistics as required and click Apply to

update.
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o
6. Click on si= Change Grouping on the toolbar to group the data by statistic rather
than by group.

7. Close the Statistics window using the X in the top left hand corner when complete.

Frequency Table

View all the unique values for each selected variable and the counts for each using a
Frequency Table.

1. Select m Display Frequency Table from the Summary Stats drop-down menu
on the Home ribbon.

2. Each variable is displayed in a separate tab.

m‘ Frequency Table EE‘E
{20.PPM; Ni_ppm Fe203 pct  Cu_ppm
Value Count Cumulative Count % Cumulative %
1.0 71 7.11 7.11 ~
2.0 17 jiti] 1.7 8.81
3.0 23 111 2.3 11,11
4.0 23 134 2.3 13.41
5.0 34 168 3.4 16.82
6.0 34 202 3.4 20,22
7.0 35 237 3.5 23.72
B.0 25 262 2.5 26,23
9.0 12 274 1.2 27.43
10.0 34 308 3.4 30.83
11.0 29 337 2.9 33.73
12.0 34 371 3.4 37.14
13.0 23 394 2.3 39.%4
14.0 34 428 3.4 42,84
15.0 24 452 2.4 45,25
16.0 21 473 2.1 47.35
17.0 25 498 2.5 49.85
18.0 27 525 27 52,55 hd

Correlation Matrix

Display the correlation coefficient values for each paired combination of selected
variables.

1. Select @ Correlation Matrix from the Analysis ribbon.
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W— Correlation - Pair [Zn_ppm, Ni_ppm, Fe203_pct, Cu_ppm] EEE
Zn_ppm Ni_ppm Fe203_pct Cu_ppm
Zn_ppm 1 0.49 0.14 0.52
Ni_ppm 0.49 1 0.4 0.75
Fe203_pct 0.14 0.4 1 0.51
Cu_ppm 0.52 0.75 0.51 1

Highly positive or negative correlated pairs of data are coloured in pink and red.
The first tab shows the correlation values for all of the visible data selected in the
Attribute Manager. The other tabs show the correlation values for each colour
attribute group.

EI Summary statistics and Frequency Table can also be accessed via the
Analysis ribbon.
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13. Variable Maps and Gridding

Variable maps and gridding are ioGAS Map tools, in addition to Attribute Maps. The
data in these plots is displayed spatially and can be exported for use in GIS
applications.

Variable Maps

A Variable Map displays each of the selected variables in a separate map view. The
data points in each map are displayed using one of the pre-defined thematic operation,
colour and size ramping options. Variable maps are good for comparing high or low
concentrations across multiple elements.

1. Select% Settings>Normal Windows from the Window band if it is not already
selected.

2. Select Variable Map from the Home ribbon.

3. By default the data for each variable is displayed according to its ranked per-
centile. To view what data values are represented by their colour and size attrib-

utes click on ED Show/hide colour bar legend on the variable map toolbar.

4. Click on “® Save Checkpoint in the Save band on the Home ribbon. Enter a name
for the checkpoint such as Variable Maps and click OK.

5. To modify the thematic settings click on e Change thematic settings on the vari-
able map toolbar.
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In addition to the ranked thematic operation, all of the other available binning
ranges in the Attribute Manager can also be used in the variable maps, for
example, quartile, progressive half, equal tails 6 groups, etc. Custom bin ranges
can also be selected here.

6. Experiment by selecting other thematic operations and observing the legend and
data points automatically updating.

7. Select from a number of different Colour and Size ramps and observe how the
data appearance changes. To see what type of size ramp is being applied place
the cursor over the entry in the pull-down list. Repeat for the colour ramps.

With the exception of the ranked thematic operation, all other binning ranges can
be coloured using continuous colour ramps or discrete colours.

8. Close all variable map windows upon completion of this exercise.

Export Variable Maps
Variable maps can be exported and viewed in Google Earth and Maplnfo.

Gridding

A grid is created from the interpolation of located data onto a regular grid or matrix that is
then rendered so that it can be viewed as a continuous coloured or shaded surface.
i0GAS includes a gridding tool that uses a modified Inverse Distance Weighting
algorithm to generate the interpolated grid cell values.

48 | © Imdex Limited July 2023 Quick Start Guide v8.1

Classification | Public



10

GAS

Only one grid window can be displayed in ioGAS at a time.

Grid (scaled by visible data) [Zn_ppm, Mi_ppm, Fe203_pct, Cu_ppm] =t -EI—B
Zn_ppm 29595 Ni_ppm 53.47
7,230,000 40,13 7,230,000 18,29
7,220,000 31,46 7,220,000 15.05
7.210,000 7.210,000
~— 7,200,000 — 7,200,000
@ R
! 7190000 2212 17190000 1178
& o
= 7,180,000 = 7,180,000
<L =L
| 7,170,000 | 7,170,000
< <
= =
o 7,160,000 o 7,160,000
= =z
7,150,000 12,83 7,150,000 73
7.140.000 7.140.000
7,130,000 7,130,000
7,120,000 7,120,000
200.000 225000 250.000 275.000 300.000 325.000 350.000 1 200.000 225000 250000 275.000 300,000 325.000 350.000 1
East AMGE4_z51 zn_ppm East AMGE4_z51 hi_ppm
Fe203_pct 56,15 Cu_ppm 107.73
7,230,000 25.26 7,230,000 24.41
7,220,000 17.6 7,220,000 19.6
7,210,000 7,210,000
~— 7,200,000 — 7,200,000
i W
! 7180000 ) 7.190,000 14.04
] ]
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= <
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= =4
7,150,000 7,150,000 7.09
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¥
T
m o . .
1. Select i Grid from the Home ribbon.
. . . .
2. The Make Grids dialog is displayed.
E Make Grids E
Pre-Gridding Operation |Ma}dmum of Cell e |
Cell Size ¥ (map units) 820.0 |
Cell Size ¥ (map units) 8200 |
Search Radius {cells) |E e |
Extend grid by search radius Il
Minimum Smoothing Radius (cells) |3 ~ |
Colouring Operation |Ur‘|equal Bins (30,80/80/90/95/98/99/100 %) ~ |
Caolour Spectrum |_ | | ~ |
Shading Direction |N ~ |
Shading Brightness 4 v/
Mo Data Colour |Greg¢r e |
186 x 137 can show 4 [ 4in about 9s [Expart will make all 4 grids]
| OK || ResetCellSze  ResstAl || Close |
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i0GAS attempts to automatically select the appropriate grid cell size settings for
the dataset based on an algorithm that analyses the spatial structure of the data.
All of the other gridding parameters including grid cell size, search radius,
smoothing, etc. can be customised.

3. Leave the default settings and click OK. The grids are displayed in a single plot
window.

4. To view the grid cell values that the colours represent click on ED Show/hide grid
legend on the gridding toolbar.

5. Overlay the attribute points on top of the grid using E Show/hide attribute map.

6. Place the cursor over the grid and use the zoom tools (or mouse scroll bar) to
zoom all the grids together at the cursor location.

7. To change the grid parameters select Display grid options from the toolbar.
8. Close the grid window upon completion of this exercise.

Export Grids

The gridded images can be exported using the GeoTiff and ER Mapper Grid export
options on the gridding toolbar.

Variable Maps and Grids can also be accessed via the Map ribbon.
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14. Diagrams, Spiders & Calculations

ioGAS contains a number of standard classification diagrams arranged into a logical
menu system. Data can be plotted on classification diagrams and then attributed
according to the classification group in which they are located. These attributes can be
written back to the file and used in further analysis or exported for use in third-party
programs.

In order to view data on a supplied classification diagram the variable columns must be
"aliased" in the Column Properties dialog as outlined in Step 3. This is so i0GAS can
perform any element/oxide/unit conversions to get the data into the correct format to
display on the diagram.

The diagrams are located under Provided on the Diagram ribbon and are arranged
into a series of sub-menus:

Rock Molar Exploration aiSIRIS Geomet Metamorphic Mineral Water
Classification ~ | Ratio = - - - - Chemistry +  Chemistry =

UGS Diagrams * Provided Diagrams

Major Elements ¥

Regolith » Classification Reqolith Fractionation {McQueen, 2006)

Trace Elements » | Weathering Trends » Tivs Zr (Hallberg, 1984)

Zr-Al203-TiO2 (Garda et al, 1994)

To view the diagram supporting information from within the Diagram>Provided menu
hover the cursor over the menu item. If a diagram is greyed out then it means that one or
more variables is not present in the dataset. The missing variable(s) are displayed in the
tooltip when the cursor is hovered over the entry.

This exercise displays the demonstration dataset on a Regolith diagram that plots K/Al
vs Mg/Al wt values to classify regolith data into transported clays, saprolite and younger
alluvium/colluvium.

1. In Provided, navigate to Regolith>Classification and select the Regolith Frac-
tionation (McQueen, 2006) diagram.
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@ Regelith Fractionation (McQueen, 2008).xml
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0.426 1
0.400 -
0375 -
0.350 |
0325 1 L
0.300 -

= 0.276 4

£

S 0250 | =

= 0225 1

= 0.200 | -y

=)

= 0175 4

LI ’
er alluviumicollfivium

0.150 [ 4

0.126

0.100

0078

0.050

0025

0.000

Bap on mafic

KIAl wi. [Locked]

The data are plotted with the current attributes onto the diagram in a new plot
window. The diagram window contains zooming, panning and selection tools the
same as found on other plot toolbars.

2. Zoom out to see that not all the data plots within the diagram extents.

3. Right-mouse click and select Zoom to Diagram from the pop-up menu to return to
the original diagram view.

4. To attribute the data points with the regolith classification group colours select o"‘
Colour Rows from Polygon on the diagram toolbar and select "YES" to overwrite
existing colour attributes.

52| © Imdex Limited July 2023

Classification | Public

Quick Start Guide v8.1



=t IOGAS
m Regolith Fractionation (McQueen, 2006) xml = PE ESe
Regolith Classification (McQueen 2006)
0.425 .
0.400
*
0.375
0.350 .o
0.325 L
0.300
= D275 = .
% Ynungeralluviumicfﬂluvium b
E 0.250 Y %
= D225 . -
S ® s
Z 0.200 o =
=] L]
= 0475 !
0.150 L‘}I‘ .
. ap on mafic
0.125 = .
0.100
0.075
0.050
0.025
0.000

000 005 010 015 020 025 030 035 nqu 0.45 050 055 0.6C
KIAI wt. [Locked]

5. Open the Attribute Manager to view the new colour groups based on the diagram
classifications. Any samples that fall outside the diagram boundaries are coloured
using the default colour black.

6. To make a new variable column which contains the regolith classification group for

[ ]
each row select e From Colour from the Make Variables band on the Data rib-
bon.

7. Leave the default column name and click OK.

EEN
8. Open up a tabular view of the data using mmm Data and scroll to the right to see
the newly added columns.

One column is text with the rock classification based on the polygon name; the
other column is numeric with a different number for each rock classification.

It is possible to make and edit your own classification diagrams and share
them with others within your organisation.
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Other Provided Resources

Aside from classification diagrams, ioGAS also provides a library of commonly used
spider normalisations and calculations under the Calculation and Spider ribbons
respectively.

Spider Plots

1. Click on the Spider tab to open the ribbon toolbar.

2. In¥

spider.

Provided, navigate to Crust and select the Av Abundance Earth Crust

Average Abundance Earth Crust

Y B TN R R R I S A T B ST S
AgBBeBIBrCdClCoCsDyErEuF GaGd GeHfHaHolInlrLuMnMNd Os PdPrPtReRhRUSh Se SmTaTh Te TITm Y

3. Use ﬂi Make variables from spider on the Spider toolbar to add normalised val-
ues for each element to the dataset as new columns.

1
4. Open up a tabular view of the data using mmm Data and scroll to the right to see
the newly added normalisation columns.

Calculations
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1. Click on the Calculation tab to open the ribbon toolbar.

fto
2. In Provided, navigate to Regolith and select the Chemical Index of Alteration

(CIA) calculation.

HEN
3. Open up a tabular view of the data using mmm Data and scroll to the right to see
the newly added CIA column.

Create Custom Diagrams, Spiders and Calculations

In addition to the provided resources, users can create their own classification diagrams,
spider normalisations and calculations.

55| © Imdex Limited July 2023 Quick Start Guide v8.1

Classification | Public



" I0GAS

15. Checkpoints and Templates

Save and Restore Checkpoints

During this tutorial we have been saving a humber of checkpoints. A Checkpoint is a
saved snapshot of an i0GAS work session taken at a particular point in time and
contains information about all of the open plot windows plus any other plot settings
including the colour, shape, size, filter and visibility attributes displayed when the
checkpoint was created.

Multiple checkpoints can be created and stored in a list for easy retrieval. At a later point
in time a checkpoint can be selected from the list and the saved plot windows and
attributes restored as the current work session, replacing the existing ioGAS display.
Checkpoints are saved with the ioGAS file.

1. To restore a checkpoint select -~/ Open Checkpoint on the Open band of the File

or Home ribbon. (This function is also available from the Open drop-down
menu on other functional ribbons.)

2. All of the saved checkpoints appear in a drop-down list in creation order (newest
on top):
SHTW Samples
DC + E Regolith Units
Multiple Plats

5 | Clear All Checkpoints

3. Select Multiple Plots from the list and Restore.

Observe how the current ioGAS session is replaced with the saved checkpoint
windows and the saved attributes are also restored.

4. Restore the other saved checkpoints.

Checkpoints can be renamed or deleted. To remove all checkpoints select Clear All
Checkpoints.

Templates

Templates enable groups of plots and customised settings to be saved and then
restored with updated or new datasets. Templates can be created that represent
standard workflows in your data analysis and can be shared with colleagues.
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Templates work with aliased data so that if the exact element/oxide/unit used in the
template is not present in the dataset but the element is available in another form, ioGAS
can convert the data on-the-fly to the required combination.

A number of commonly used plot combinations have been created for you and are
available in ioGAS.

1. Goto = Provided in the Open Templates band in the File ribbon or alternatively

from the Open drop-down menu on any of the functional bands (Home, Data,
Calculation, Analysis, etc.).

2. Select the Alteration Plots template. Hover the cursor over the template entry to
view the contents.

3. Inthe Choose dialog select Template. This will use the stored plot axis ranges in
the template when opening up the plot windows. The Default option will re-scale
the axis ranges using the current dataset.

Templates do not replace the currently open plot windows so multiple
templates can be open at the same time.

4. Use Close All on the Window band of the Home ribbon to close all windows.

Create Custom Templates
In addition to the provided resources, users can create their own templates.
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16. Save, Copy, Export and Print Options
Save ioGAS File

1. Click E Save from any of the ribbons (other than Help).

2. Enter a name for the file and save to your desktop.

The Save option saves both the current data and the attribute information as a
native ioGAS file. Any open plot windows are also saved and will be re-opened

when the file is next loaded. To re-open a native i0GAS file use the Open
menu option.

Save As ioGAS File

To save a copy of an ioGAS file select HA Save As from the Save drop-down menu
and choose ioGAS File from the Files of Type pull-down list.

Copy Options

Before copying a plot window as an image or vector file you may want to modify some of
the plot parameters such as plot title, axis ranges, label colours, etc. These parameters
can be changed by one of two ways:

« Plot Settings - Affects individual plots only and includes options to show/hide plot
title, change title text, show/hide axis labels, change axis label text and modify axis
ranges. Right-mouse on an individual plot and choose plot settings from the pop-
up menu.
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Plot Settings

Title

Show Title
Text: Zn_ppm : Fe203_pct

X axis
Use default label

Label:
[ ] Lock Axis

Zn_ppm
Minimum value: -10.34
Maximum walue: 390.34
[ ] Reverse axis

Y axis

Use default label
Label:

[[] Lock Axis

Fe203_pct
Minimum value: -1.5804
Maximum value: 65.6204
[ | Reverse axis

Cancel

« Plot Window Style Settings - Affects all plots in a window and includes options to
change title and axis label font, colour and size, show/hide tick marks and labels,

tick label font, colour and size and show/hide gridlines. Click on HE Plot Window
Style Settings on selected toolbars to access this dialog:

ﬁ Plat Window Style Settings

Title

Font: SansSerif.bold, 18

Colour: |

Axes
Axis label font:

Colour:
Show tick labels
Tick label font:
Show tick marks

Flot
Label font:

Colour:

Show gridiines

=+ Apply

¥ Close

SansSerif.plain, 12

|
[ vertical tick labels (x axis)

SansSerif.plain, 10

SansSerif.plain, 10

4= Reset Al

Select...

Select...

Select...

Select...

Select...

Select...

4 Save Settings
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Copy Window as Image
This option creates a bitmap image of the active window and copies it to the clipboard.

1. Use the Ctrl-C keyboard shortcut (Windows)/Command-C (Mac) or click % Copy
Window on the File or Home ribbons.

2. Paste into a third-party program such as Word, PowerPoint or image processing
package using right-mouse click + Paste or Ctrl-V (Windows)/Command-V (Mac).

Selected plots such as scatterplots, scatterplot matrix, variable maps and line plots

have a Copy Window % button on their toolbar to copy the window at high
resolution for large scale plotting, e.g. at A1 or A0 size.

Copy Plot as Image
1. Right-mouse click in an individual plot window and select from one of the following
Copy options. The bitmap copy has a number of screen resolutions. The larger the
resolution the larger the resulting image which is created.

Copy

Copy 800x600
Copy 1200900
Copy 24001200

2. Paste into third party program such as Word, PowerPoint orimage processing
package using right-mouse click + Paste or Ctrl-V (Windows)/Command-V(Mac).

It is also possible to copy windows in EMF (Enhanced Metafile format) and EPS
(Encapsulated Post Script format). These are both vector based file formats that
enable the image to be re-sized while retaining resolution and editing of the
individual map components in other programs such as Corel Draw, Paint Shop,
PowerPoint and Word.

Save Plot as Vector File
1. Right-mouse click in the graph window and select from one of the following Save
options.

2. Enter a name and location for the saved file.
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Copy ]

Save ‘= SaveEPS
| =% Save EMF
[ =% SaveSVG

The EPS (Encapsulated Post Script), EMF (Enhanced Metafile) and SVG
(Scalable Vector Graphics) are all vector based file formats that enable the image
to be re-sized while retaining resolution and editing of the individual map
components in other programs such as Corel Draw, Paint Shop, PowerPoint and
Word.

Export Data

1. Go to the File ribbon to see options available in the Export band. Under = Al ,
choose Export (All Rows) or Export (Visible Rows).

i0GAS can export data in the following formats:
« Excel Spreadsheet File

o« CSV TextFile

o Tab Separated Text File

Google Earth KMZ File (as Attribute Map)
AutoCad DXF File

All Rows will export all the rows in the dataset whereas Visible Rows will only
export data that is set as visible in the Attribute Manager. The Visible Row export
option is good to use when you need to sub-set data into a separate file.

The = Selected option will export only the columns flagged as special in the
Column Properties dialog plus the columns selected in the Select Variables
dialog. Options to export all rows and visible rows are available from the drop-
down menu.

Print

To print an individual graph directly from a plot window right-mouse click and select
Print from the pop-up menu.
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17. GIS Options

Google Earth

Attribute Maps and Variable Maps can be exported to Google Earth. When the Attribute
Map is exported to Google Earth, the shape, colour and size attributes are rendered
correctly. Variable Maps can also be exported into Google Earth, and like in ioGAS their
colour and size are retained.

To export into Google Earth, the dataset must contain coordinates for each data pointin
Lat/Long WGS84 projection and these columns must be selected as the WGS84
Longitude and WGS84 Latitude columns in the Column Properties dialog (see Step 3).
If the dataset only contains a projected coordinate system, it is possible to generate
WGS84 coordinates using the WGS84 Long/Lat tool in ioGAS.

1. To export to Google Earth use % on the Attribute Map or Variable Map toolbars.

Attribute maps can also be exported to Google Earth via t—b Google Earth on the

Attribute Map Export band on the Map ribbon or from the E-ﬂ All or -!5Selected
options on the Export band of the File ribbon.

The colour, shape and size attributes are displayed in a pop-up window in Google Earth
along with selected variable values and Sample ID. Other data may be displayed if it
has been selected in the Select Labels.
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ArcGIS Pro

Users of ESRI 64-bit ArcGIS Pro can import ioGAS attributed data using the ioGAS for
ArcGIS Pro plugin available for download from our website.

See ioGAS for ArcGIS Pro for more information.

QGIS

Users of QGIS can import ioGAS attributed data using the i0GAS for QGIS plugin
available for download from our website.

See ioGAS for QGIS for more information.

Mapinfo

This option saves an Attribute Map or Variable Map including any colour, shape, size
and visibility attributes and exports them to a MapInfo TAB file. The associated legend
window is exported as a separate Mapinfo TAB file as well. The Export to Mapinfo
utility is available in both the ioGAS 32 and 64-bit versions.

1. In the Column Properties dialog make sure that the East/North Projection is selec-
ted to match the coordinates in the selected East and North columns. If a non-
earth projection is selected the data can still be opened in Maplnfo but not overlain
with other projected datasets.

2. To export to MaplInfo use % on the Attribute Map or Variable Map toolbars.

Attribute maps can also be exported to Maplnfo via fr—_b Maplnfo on the Attribute
Map Export band on the Map ribbon

3. Assign a name and location for the Maplnfo file and click Export.

4. Open Maplnfo, browse to the Tab file and open.

The colour, shape and size attributes are exported along with selected variable values
coordinate columns and Sample ID.

ioGAS attributed data can also be imported into Mapinfo using the
Datamine Discover Import Utility.
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18. Additional XY Scatter Plot Tools

Now that you are familiar with opening up data into ioGAS and doing some of the basic
workflows here are some additional tools available from the XY and diagram toolbars to
investigate further:

Mineral and rock nodes

Individual or groups of minerals or rocks can be plotted as nodes within selected graphs
(scatter plot, SPLOM, ternary, downhole, etc) and classification diagrams using the
following toolbar buttons:

ﬁ Show mineral and rock nodes - Cycle through available mineral or rock node
displays or right-mouse click and choose mode - nodes, node lines, node names

or node description.
%1 Mineral and rock node settings - Select the mineral or rock nodes to display.

In order to display mineral or rock nodes on a plot, the variables used as the plot or
diagram axes must be "aliased" in the Column Properties dialog. Mineral nodes can be
projected regardless of oxide/element/unit of the geochemical variables displayed as
the plot axes, even if the plot has calculated axes (including PCA). The currently
selected mineral and rock nodes can be displayed on multiple plots and the current
selection saved between work sessions.

Use the settings dialog to select the mineral and rock nodes and the show mineral and
rock nodes button to display the nodes.

It is also possible to add your own custom user nodes to the mineral and rock node
library.

Point density grids

A point density display is a grid of the density of the data points within selected graphs
(scatter plot, SPLOM, ternary, etc) and classification diagrams to make it easier to
visually determine where most of the data is concentrated.

Use the settings dialog to set up the point density grid parameters and the point density
opacity button to display the grid.

{5’;’ Point density opacity - Cycle through available point density opacity settings or
right mouse-click and choose mode.

Point density settings - Modify Point Density Grid Settings.
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Mean/median crosses
Display mean and median crosses for entire dataset or colour group on selected plots
and diagrams.

x  Show means - Cycle through displaying location of mean for entire dataset or
visible groups using solid cross symbol or right-mouse click and choose mode.

,;" Change mean crosshair size - only active when mean crosses displayed on
plots. Cycle through displaying mean crosshairs sized by 1 x standard deviation
or 2 x standard deviations or right-mouse click and choose mode.

%  Show medians - Cycle through displaying location of median for entire dataset
or visible groups using dashed cross symbol or right-mouse click and choose
mode.

Regression & Y = X lines

Display regression and Y=X lines in selected plot windows. Two types of regression
methods are available in ioGAS: ordinary least squares (OLS) and reduced major axis
(RMA). The OLS method can also be forced to display through the origin (RTO).

Show regression line - Cycle through colour group and/or all data regression
line display or right mouse-click and choose mode.
Place the cursor over a regression line to view the m (gradient), c (intercept) and
r2 values in a tooltip.

fiu  Change regression type - Cycle through least squares regression, regression
through the origin (RTO) and reduced major axis (RMA) regression or right
mouse-click and choose mode.

Ié Show liney = x - Toggle to display Y = X trend line in plot window for entire
dataset.

Mahalanobis Contour Ellipses

Classical and robust M-Dist ellipses can be displayed quickly on XY and SPLOM
(scatterplot matrix) plots by using two options on the XY toolbar. The parameters used to
display the M-dist ellipses are the same as the default input parameters for the M-dist
methods available via the Analysis menu:

o Classical M-dist

« Robust M-dist (M-estimation) - ellipses calculated using Medium outlier rejection
algorithm

« Robust M-dist (Fast MCD)
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The ellipses may be displayed for all data, each colour group or both with four chi-
squared cut-off values: p = 0.5, 0.95, 0.975 and 0.99 available.

,f; Show Mahalanobis contour ellipses - Cycle through p = 0.5, 0.95, 0.975 and

= 0.99 Mahalanobis ellipses or right mouse-click and choose mode.

<. Show robust Mahalanobis contour ellipses - Cycle through p = 0.5, 0.95, 0.975
and 0.99 Robust Mahalanobis ellipses or right mouse-click and choose mode:
The ellipses are calculated using the M-Estimation or Fast MCD robust
algorithm. To set the algorithm to use see Calculate Mahalanobis Distance.

,j_’l M-dist ellipse display mode - Cycle through to show M-dist ellipses by colour
= group, by colour group + entire dataset and entire dataset or right mouse-click
and choose mode.
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19. Drillhole and Structural Data

ioGAS contains specialised tools for working with drillhole and structural data.

Drillhole Data

For examples of the following tools in action in ioGAS go to Open>Open Demo Data on
any ribbon and select Open Drillhole Demo Data.

Attribute Map 3D

Select Attribute Map 3D on the Home or Map ribbon to display drillhole data using
geographical XYZ coordinates in a 3D plot window. Individual data points can be
attributed with up to three variables using colour/shape/size using the Attribute Manager
and rotated to view their distribution within the dataset. Areas of interest can be isolated
using visibility or filter controls. The 3D Attribute Map window updates dynamically like
any other ioGAS plot window and data can be selected and attributed for closer
analysis.

The dataset must contain east (X), north (Y) and elevation (Z) data columns which are
mapped to East, North and Elevation in the Column Properties dialog.

“# Attribute Map 3D =8 =R

300
275
250
225
200
175
180

125
100
75
50
25 I
0
25
-50
75
-100
-125
-150
-175 \
-200
-225
-250
-275
-300

[Locked]

R

300 250 -200 150 100 -50 0 50 100 150 200 250 300
Dip ¥=-80 Bearing=0 Dip ¥=-90 V.E.=3.86 [Locked]

Downhole Plots

Select Downhole on the Home or Graph ribbon to generate a downhole plot, or visual
representation of drill hole data plotted on a vertical axis. Create individual plots using
Hole ID and depth from/to or RL/elevation data.
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Three downhole plot types are available. The multi-trace downhole plot can display up
to 8 selected variable traces for one drillhole along its axis. Alternatively, each selected
variable or group can be displayed in a single downhole plot. The distance along the
axis of the downhole plot represents the distance in specified interval units. The traces
on the plot are visual representation of numeric values of the selected variables.

XYZ1073 XYZ1073 XYZ1073 XYZ1073
Au_ppm As_ppm Sh_ppm Cu_ppm

©o1E

HYZ1073 Depth
&

o

00 05 10 15 20 25 0 500 1,000 0 250 500 100 200 300
Au_ppm As_ppm Sh_ppm Cu_ppm

Downhole plot axes can be logged, zoomed and show common or individual axis
scaling. Data points can display the current colour, shape, size and visibility and can be
selected and attributed in the same way as in other plot windows. The colour bar
alongside each downhole plot represents the current colour groups as set in the
Attribute Manager.

Structural Data
For examples of the structural tools in action in ioGAS go to Open>Open Demo Data on
any ribbon and select Open Stereonet Demo Data.

Select Stereonet on the Structure ribbon to generate a stereonet using Dip and Azimuth
(Dip Direction) measurements. A Stereonet is a graphical representation of 3D structural
data on a 2D surface and is used to analyse the angular relationships between lines
and planes in 3D space. The stereonet plotting functionality in ioGAS includes the
ability to plot lineations and planes, determine means per colour group, calculate beta
axes, change plot projection on-the-fly and produce in-built calculated statistical reports.
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Shape
@ Default Shape
Size
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POng_Iunge =62.7%, azimuth = 207.8%

Other structural tools available include alpha/beta/gamma structural data conversion

and rose plots.
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20. Multivariate Analysis Tools

Many of the analysis tools within i0GAS are located on the Analysis ribbon and are
grouped into the following bands:

Statistics

Transformation

Outlier Analysis

Supervised

« Unsupervised

We visited some of the more simple statistical tools during this tutorial however some of
the more advanced tools require a deeper understanding of the underlying theory
behind multivariate analysis before they should be used. A summary of the available
analysis tools is provided below:

Statistics Band

Summary Statistics

Generate summary statistics for all variable columns as designated in the Select
Variables dialog. Summary Statistics include count null, count zero, maximum,
minimum, range, mean, median, percentile values plus many others. Statistics selected
for display is fully customisable. Under the Summary Stats drop-down menu is the
following option:

Summary Statistics (Special Columns)

Generate summary statistics for all special columns as designated in the
Column Properties dialog. Special columns include Sample ID and
coordinate columns.

E_H Frequency Table

A frequency table indicates how many samples fall into each individual category or
numeric value within the selected variable columns. Under the Frequency Table drop-
down menu is the following option:

¥ Frequency Table (All Columns)

Display frequency tables for all of the columns in the dataset.
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CrossTab

Create a CrossTab table to show the count, mean, median, standard deviation,
coefficient offset, minimum and maximum values for the selected numeric variables
based on two categorising variables.

@ Correlation Matrix

Display the correlation coefficient for each pair of selected variables. Results can be
calculated using classic Pearson or Spearman Ranked methods.

Regression

Regression analysis is used to determine the linear equation(s) that model the
relationship between response and explanatory variables. Simple and multiple
regression analysis are both available as well as a robust option to down-weight
outlying data points.

Transform Band

| Centred Log Ratio

Centred Log Ratio (CLR) transformation is used for "opening" constant sum data.
Geochemical data sum to a constant (100% of mass) producing closure effects in data
that may lead to induced correlations. The CLR transformation ‘opens’ the data and can
be helpful for removing spurious correlations. This is especially the case with major
element data.

JAWAN
Make Levelled Columns

Apply levelling operations (mean, median, Z-Score, etc) on selected data columns to
distinguish anomalous values within datasets that contain multiple populations, e.g.
different rock types, regolith units, mesh sizes, laboratory analysis methods, etc.

VARPAN
Weighted Sums

Weighted Sums is a simple multivariate technique used to reduce several variables to
one variable where there is prior knowledge about the underlying processes. Each
variable is assigned an importance value which is then normalised to make 'weights' so
that the sums of the squares of the applied weights is 1.
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Outlier Analysis Band

Auto-Attribute Tukey Outliers

Run a Tukey box plot algorithm and assign size and shape attributes to outlier samples
that plot outside the main Tukey plot fence so they can be identified in other plots. Under
the Tukey Outliers drop-down menu is the following option:

= Auto-Attribute Tukey Outliers (Logged)

Run a Tukey box plot algorithm on log-transformed data and assign size and
shape attributes to outlier samples that plot outside the main Tukey plot
fence as they can be identified in other plots.

0 M-Dist (Compute Mahalanobis Distances )

Mahalanobis Distance (M-dist) is a multivariate analysis technique based on the means
and variances of selected variables and on the covariances between each pair of
variables. It is used to determine how far a sample value "lies" from the central tendency
of a data group. Two robust M-dist algorithms are available in which "outlier" samples
have reduced impact on the overall Mahalanobis distance calculations by assigning
them less weighting. Under the M-Dist drop-down menu are the following options:

& Classical
Standard M-dist calculation devised by P.C. Mahalanobis.
&: Robust (M-Estimation)

Robust variation of M-dist calculation based on the algorithm devised by
N.A. Campbell.

©. Robust (Fast MCD)

Robust variation of M-dist calculation based on the algorithm devised by P.J.
Rousseeuw and K. Van Driessen.

k= Distance-Distance Plot
Scatter plot of classical M-dist values vs robust Fast MCD M-dist values.
Set Robust M-Dist Algorithm

Choose robust algorithm to use in the Anomaly Assessment Tool and when
displaying robust M-dist ellipses on scatter plots.
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Anomaly Assessment Tool

The Anomaly Assessment Tool (AAT) identifies outliers or atypical samples within
domain classified data using a combination of a univariate test (Tukey) to isolate near
and/or far outlier samples plus a multivariate test (robust variant of Mahalanobis
Distance) to examine variable correlations within each domain.

Supervised Band

‘oS DPA

Discriminant Projection Analysis (DPA) emphasises the projection component of
discriminant analysis to produce visual outputs for exploratory data analysis. Samples
are projected into a lower dimensional space to best show the separation between
groups graphically. There are two steps involved in DPA: the 'projection step' and if
required, the 'classification step'. DPA may also be used as an exploratory technique to
indicate which of the selected variables are most important for determining maximum
group separation. Under the DPA drop-down menu is the following option:

Variance Importance Plot

Find the subsets of input variables that best discriminate colour groups under
DPA.

[ 4
= Auto-Domain

Automatically create a classification diagram from data groups. These groups could be a
priori knowledge or generated from the K-means clustering or Discriminant Projection
Analysis tools. Group boundaries are created using Mahalanobis Distance calculations.

ﬁ CART (Classification and Regression Trees)

CART is a non-parametric supervised machine learning algorithm used in the
generation of decision trees. Decision trees are predictive models which devise an
optimum set of parameters to classify a sample into one of a set of groups. Trees are
comprised of binary decision nodes which split data based on selected criteria until
each sample is allocated to a leaf node representing one of the input target groups.
Under the CART drop-down menu are the following options:

%z Classification Tree

Decision tree using categorical input target groups.

74| © Imdex Limited July 2023 Quick Start Guide v8.1

Classification | Public



I0GAS

-2 Random Forest

Build multiple classification trees at the same time.

%z Regression Tree

Decision tree using continuous (numeric) input target group.
. Open Tree From XML

Browse to the location of a calculated tree *. XML file to open.

Unsupervised

4 PCA

Principal Component Analysis (PCA) is a multivariate statistical technique used to
reduce the dimensionality of data so as to maximise the variance. PCA finds the best set
of linear equations to use to reduce the number of variables that are needed to describe
a dataset. Reducing multivariate data to 2 or 3 derived variables enables it to be more
readily visualised. Under the PCA drop-down menu are the following options:

4 Classical
Standard PCA calculation.
¢ Robust (M-Estimation)

Robust variation of PCA calculation based on the algorithm devised by N.A.
Campbell.

¢ Robust (Fast MCD)

Robust variation of M-dist calculation based on the algorithm devised by P.J.
Rousseeuw and K. Van Driessen.

‘< Biplot

Two dimensional plot showing combinations of principal components 1 to 4
and original variables as vectors.

&< 3D Biplot

Three dimensional plot showing principal components 1 to 3 and original
variables as vectors.
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I SOM

Self-organising map (SOM) is an unsupervised training algorithm using neural networks
to produce rapid classification of groups within a dataset. Under the SOM drop-down
menu are the following options:

M Create New SOM

Generate a new self organising map.

User

Library of user created SOMs.

W Open Other SOM

Browse to the location of the SOM * XML file to open.
Recent

List of recently opened SOMs.

“" Clustering
Apache k-means unsupervised clustering algorithm to partition a population of data into

smaller sub-populations. Use to interrogate the grouping structure between variables
and to prepare the dataset for further interpretation.

# k-Means Clustering
Generate clusters using k-means method.

& DBSCAN

Density-Based Spatial Clustering of Applications with Noise (DBSCAN)
unsupervised clustering algorithm

> UMAP
Uniform Manifold Approximation and Projection (UMAP) is an unsupervised, non-linear
machine learning dimension reduction technique used for the analysis and visualisation
of high-dimensional data in low-dimension 2D or 3D space. Similar to t-SNE, UMAP
generates clusters of data points containing similar values based on multiple features
and is also useful for identifying outliers.
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.* ¢ t-SNE

t-distributed Stochastic Neighbour Embedding (--SNE) is an unsupervised, non-linear
machine learning dimension reduction technique used for the analysis and visualisation

of high-dimensional data in low-dimension or 2D space.

= Wavelet Tessellation

Wavelet Tessellation is two analytical approaches to processing complex signals
integrated together into one workflow. A wavelet transform is a process of performing
multi-scale edge detection on a signal using a Gaussian wavelet transform (DoG
wavelet) for which the second derivative is known as the Mexican Hat filter The
tessellation is a method of mapping regularised geometries onto the wavelet transform
to better visualise the signal and help the correlation to natural patterns in the geology.

A'l

¥ Recurrence plot

A recurrence plot provides a way to visualise the periodic nature of a trajectory through a
phase space. When combined with a weighted quadrant scan, recurrence plots can be
used to detect transitions in geological spatial data using multiple variables to define
different lithological boundaries.

21. Workflows

The workflow ribbon comprises a number of tools to enable the recording of a series of
ioGAS operations that can be played back on demand. Automating repetitive actions
through the use of workflows enables increased time available to spend on in-depth
data analysis.

Actions such as importing data, setting column properties, aliasing, data validation,
variable selection, point attribution, opening of plot windows including classification
diagrams, running calculations and performing advanced data analyses are
automatically recorded and linked together into a single workflow that can be saved and
run with the same or different datasets. Manual actions requiring user input such as
selecting data populations or outlier samples in a plot window can also be included as
operational steps.

The following steps outline how to create a simple import workflow:

Record Workflow
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1. Select'{h‘ ® New Import Workflow from the Workflow ribbon. The Workflow Editor
dialog is opened in ***RECORDING*** mode.

2. Click the Open button on the File ribbon, or any other functional ribbon (other
than Help).

3. Browse to one of the following locations depending on the installed operating sys-
tem:

« Windows (64-bit): C:\Program Files\ioAnalytics\ioGAS-64.Ver-
sion\demodata folder

« Mac installation: ioGASApplic-
ation\Contents\Resources\app\demodata folder

4. Use the drop-down arrow next to Files of type: and select Excel Spreadsheet files
- all (.xIs, .xlIsx files).

5. Highlight the demo.xlsx file and click on the Open File button.

E Open File
Look in: | demodata v| ? o [T~
. B33 demoa.drillholexlsx
:j B33 demo.stereonets.xlsx
nt) o
Recent Items demo.xlsx
Desktop

Documents

This PC
L# File name: demno., xsx Open File
Netwark Files of type: | Excel spreadsheet files - all (s, .dsx files) ~ Cancel

6. In the Column Properties dialog click on the East/North Projection drop-down list
in the Special Columns area and choose AMG (AGD84) UTM Zone 51.
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7. Click on the Guess Aliases
the element and unit from the original column name for all columns.

E Column Properties

L Guess Aliases

button. ioGAS automatically guesses

Special Columns

Column Mame and Type

D Sample Mum

East East_AMGE4_z51

Marth Morth_ AMG84_z51
East/Morth Projection AMG (AGD 84) UTM Zone 51

Elevation

WGS84 Longitude (decmal degrees) Long_WGSa4

WES84 Latitude (decimal degrees) Lat_WGS84

DateTime

« | (Google Earth Expaort)

- Counts

Original Name Alias Type Humeric Text Nulls
Sample Mum L o Kg Sample Mum ~ | i |Text w~ | 0 299 a “
East_AMGE4_z51 - I(o East_AMGE4_z51 ~ | i) |Numeric ~ | 999 o a
Morth_ AMGS84_z51 - Ko Morth_ AMGE4_z51 | | Numeric w989 0 1]
Long_WGE584 - ICO Long_WGE584 ~ | iy |Numeric ~ | 999 o a
Lat_WG584 L ICO Lat_Wa584 ~ | i |Numeric ~ | 999 u] o
Regolith Unit - Kg Regolith Unit ~ | i |Text w~ | 0 299 a
Geology 4= L) Geology v | iy [Text v| 0 999 0
Sample Medium - Kg Sample Medium ~ | i |Text w~ | 0 299 a v
£ >
Column Colour Legend File contains 339 rows and 41 columns
@ Text @ Numeric @ MNumeric, Aliased

& Non-plot @ MNumeric, Derived @ Mumeric, Aliased, Derived 4= Reset Allases Rg Guess Alizses X Cancel
3 Name Error

8. Click OK to exit the Column Properties dialog.

9. Clickonthe X Select Variables ribbon button and select Cu_ppm and Zn_ppm.
Click OK to close the dialog and Choose Yes in the following dialog to add these
columns as source columns to the workflow.
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[ Select Variables (0 / 41) o - [

~Group

Provided: |ELEMENT GROUPS : ~
User: USER. GROUPS : v | |[=k

History: ~

- Available ~Selected

Ba_ppm LS (Cu_ppm
ICe_ppm Zn_ppm
ICr_ppm
La_ppm
Li_ppm
Mo_ppm
Nb_ppm
Ni_ppm
Pb_ppm
Rb_ppm
ISC_ppm
Sn_ppm
Sr_ppm
Th_ppm
U_ppm
V_ppm
W_ppm
¥_ppm

ze_ppm ¢ |[o ]| B

pH v

& WL

Oy

=p Apply v OK ¥ Cancel

10. Selectm Data Doctor on the Data ribbon. Choose Replace all and click Apply.
In the following dialog select Record individual replacements.

Close the Data Doctor dialog when finished.
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{6 Data Doctor [As_ppm, Ba_ppm, Cu_ppm, Mo_ppm, Ni_ppm, Pb_ppm, (+1]] bt
~Data Problems
Variable Problem Value Count Yo Apply Replacement Value Replace Value
Attributes
As_ppm
No Probs
Ba_ppm
No Probs
Cu_ppm
Negative
Mo_ppm
No Probs
=
Ni_ppm Record 2 individual replacements in workflow, or record 'Replace All' operation {j.e., auto-fix all problems in current dataset)?
No Probs it
Pb_ppm Record individual replacements Record 'Replace All' operation
p! P P
No FProbs
In_ppm [
Negative 2 71 71 O
[ Suggest row by row [] Suppress Negative rule [ Attribute all Replace all
805/999 rows without any problems

Show Log = Apply Copy * Close

11. Go to the Home ribbon and click on the ‘ Attribute Manager button. Auto-
attribute by colour using the Regolith column and auto-attribute by shape using the
Geology column.

¥ Attribute Manager
[ 17 . .
#& Colour - Regolith Uit ;;‘.: Shape - Geology ol Size - W Filter -
Name Visible Colour Rows Rows visible
Default Colour ] 0 0
09 & 215 215
DA 152 152
DC 9 479 479
E & 153 153
S i L &Y
Regolith Unit | 10 Equal Bins [ | ﬁ Auto-Attribute
<> Al Visible 25 All Invisible e, Invert Visibiity |-/ save Attributes "l | gad Attributes
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12. Go to the Home ribbon and open an Attribute Map, XY Plot window, Probability
Plot window and Histogram window.

13. Click on Tile in the Window band.

Fle | Home | Data  Calcston  Analyss  Graph  Map  Stucure  Diagiam  Spider  Workfow(BETA)  Heb Q- B 4-0-06
= OpenRecent » 2 Copy Window @ « P~ z e Istow  wne % B [~ %
D) Open chedpoint » Dimecrioort| K M temary |2 pownhole Ll 0 L
pen s Sekect  Atrbute Data  Pase Undo Redo | Summary | XY Probabity Varisble Attrbute Attrbute  Grd | Legend Windows Window
T A Reverttosaved ~ HiSweTemplote | Vorsbles~ Moanager v Updates - - | Swie | Potv Plotv fiBoxPlis > gl Hstgrem | Mep Mep Map®D - T settngs v B Close Al
pen save Tools st Plots vaps Vindow
+ Histograms [Cu_ppm, Zn_ppm] = [& [ | L XY Plot (Cu_ppm, Zn_ppm]
Cu_ppm Zn_ppm Cu_ppm : Zn_ppm
a5 =50 75 a
|

Count
R
Zn_pom

150 S 20 s [
150 « .
125 200 g 1
5] s
100 ' 3
150 100 '
& ot
00 LA i B o 7 g
. - ol ; . [
v
- « WSl - CER < |li&
- g
-, = R v
o -—— — o = o 4
¢ 1w om w @ 7 @ w w0 10 1@ ¢ = w w0 o w0 a0 0 0 5 m @ @ @ @ @ % s s w0 s 7 76w s s s w0 s o s me | Mg
20 bin 5.950 wide 20 bins 18.900 wide Cu_ppm
- Probailty Plot [Cu_ppm, Zn_ppm] = [@ [ | Attribute Map o [® (%
Cu_ppm Zn_ppm Attribute Map
120 o s o,
a7s 7230000 BTy vypnd ity fiood
ity vy ¥V [N
o a0 RAMAIABNNES \
- 7220000 ey YW AN
100 « YT Y,
. o,
Y a0 7210000 MM Y
@
s 7200000 w
@ £ 250 =
% 7100000
25 d
e - . 3
£ 5 200 & 780000
X ¢ ] H
3 s
3 S 2 70000
150 £
2 7100000
w 25 A
¢
2 / 100 780000
s
E 3 740000
50 ¥ .
o 730000 Y
25
- VLT
olaa 0{ 1 & 11— 120000 u
30 25 20 15 10 05 00 05 10 15 20 25 a0 30 25 20 4s 10 G5 00 05 10 15 20 25 a0 o 7ea0 00000 zwsoo0 20000 a0 00000 GsQ00 30000 G7a000 400000
Normal score Nommal Score East AMGB4_z51

14. In the workflow Editor dialog click on the Stop *® button.
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Workflow name:

r Input Columns r Output Columns
ICu_ppm
[Zn_ppm
Regolith Unit
Geology
E3 &= =
Step Operation Motes Status  Add Delete
1 Import data Open data from chosen source E) @ ~
2 gztsn;na:?;zgserhes. Set [Projection=AMG (AGD 84) UTM Zone 51] @ @
3 Select Variables [Cu_ppm, Zn_ppm] @ @
4 Data Doctor [Cu_ppm, Zn_ppm] E) @
5 Attribute Manager @ @
g Auto-Attribute Colour on Reqgolith Unit @ @
7 Auto-Attribute Shape on Geology @ @
8 Attribute Map @ @
9 XY Plot B B
10 Probability Plot @ @
11 Histnarams 7L 2, h

Controller

Auto-confirm all dialogs during playback Clear all attributes at start of playback Remember window locations

¥ Clear E Save E Save As

» » | L ]

¥ Close

15. Save the workflow to your computer and close the Workflow Editor dialog.

16. Close the demo.xlIsx file in ioGAS using File>Close File ribbon option.

Playback Workflow

17. Click on the Workflow tab. Go to the Run band and click on Recent. Select Demo
Import Workflow from the list of recently used workflows.
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18. When the User Input Required dialog is displayed, use the Open button to
browse to the location of the demoxIsx file to open it

Workflow Qutput: Demo Import Workflow o (Bl

— Import data

User Input Required

@3 Import data
¥" Open data from chosen source
Click 'Centinue' when data is loaded.

When the data is loaded, click the Continue button in the Workflow Output
window to keep running the workflow.

19. The workflow will run to the end, selecting the variables, validating the data,
attributing the data, opening the plots and tiling the windows. The Workflow Output
dialog lists each of the workflow operations performed.

84| © Imdex Limited July 2023 Quick Start Guide v8.1

Classification | Public



I0GAS

Fie
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@ Recent »
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&
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= B
= ° I B o
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120 o
7 720000
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s 7220000
100
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@ - 20 5
% 7100000
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Support

/ Customer Service Portal

The Help ribbon provides access to the IMDEX Customer Service portal for existing
i0GAS users. Search the ioGAS knowledge base, get help or request an enhancement.
The support portal can also be used to lodge licence requests. A one-off registration is
required to access the customer service portal.

Where possible include a screen capture of the Help>About information and a copy of
the log.txt files. (Use Browse to Logs on the Help ribbon to locate the log files).

Technical support is not intended to provide remote training in the software. For training
enquiries please contact iogas@imdexlimited.com.

Technical support is available for maintained clients only. Server and
single seat (timed) licences automatically include technical support.
Existing single seat (perpetual) licence holders must pay an ongoing
annual maintenance fee in order to continue to receive technical support.

@ Email Support

Email support is available for trial users and existing ioGAS clients who are unable to
access the IMDEX Customer Service Portal.

Contact Details:
Email: iogas.support@imdexlimited.com
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